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INNLEDNING 

BIM 

BIM (bygningsinformasjonsmodell) er et 

begrep som brukes om prosjektering hvor 

det benyttes digitale 3D-modeller til å høste 

og berike informasjon i tegninger. For å 

kunne benytte deg av BIM må man ha et 

prosjekteringsverktøy som er 3D-basert og 

utviklet for å kunne jobbe med intelligente 

bygningselementer slik som f.eks. ArchiCAD. 

Fordelene med BIM-prosjektering er at man 

kun gjør endringer eller tilfører nye 

elementer én gang. Alle involverte tegninger henger sammen og blir kontinuerlig oppdatert gjennom 

alle prosjekteringsfaser. BIM-modeller kan utveksles med andre og benyttes i alle fag via IFC som er 

et fritt intelligent utvekslingsformat.  

 

ARCHICAD PÅ DATAMASKINEN 

ArchiCAD installeres og leggers på samme sted som alle andre program som installeres på 

datamaskinen. 

På Windows og Windows Vista vil stien til denne mappen være: 

C: > Programfiler > Graphisoft > ArchiCAD 14 

På Mac vil stien til denne mappen være: 

Macintosh HD > Programmer > Graphisoft > ArchiCAD 14 

Viktig! 

Innholdet i denne mappen skal ikke endres/slettes. Filer skal heller ikke lagres i/flyttes til denne 

mappen. Unntaket er dersom man spesifikt får beskjed om dette (for eksempel ved oppdateringer 

eller installering av Add-Ons) 

Prosjektfiler skal lagres et annet sted på maskinen eller på en server. 

 

Notater: 
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STARTE ARCHICAD 

En mal skal alltid brukes når man tegner i ArchiCAD. Dette for at man alltid skal ha de riktige 

innstillingene inne i programmet. Velg BOLIGabc prosjekteringsmaler, se rute 3. 

Oppstartsvindu ved nytt prosjekt. Velg dette 

oppsettet første gang du skal åpne ArchiCAD. 

 

 

Oppstartsvindu ved åpning av et prosjekt. Denne 

muligheten bruker du dersom du skal arbeide videre 

på et prosjekt.  

 

1. Create New Project: ved oppstart av nytt 
prosjekt. Velg Create New Project første 
gang du skal bruke ArchiCAD. 

2. Open a Project: åpne et eksisterende 
prosjekt. Denne bruker du dersom du 
allerede er i gang med å tegne i ArchiCAD. 

3. Use a Template: velg malfil. For å benytte en 
annen mal enn den som ligger standard 
klikker man og velger Browse. Etter at filen 
er lokalisert vil den ligge i listen neste gang 
ArchiCAD startes. Du kan her velge hvilken 
vanskelighetsgrad du ønsker å arbeide med 
innenfor de tre ulike oppgavenivåene i 
BoligABC.  

4. Use Latest Project Settings: åpner en ny fil 
med alle innstillinger til prosjektet som sist 
var åpnet på denne maskinen.  

5. Set up Work Environment: velg 
arbeidsoppsett. Velg BoligABC. 

6. New: velg denne for å starte modelleringen. 
 

1. Create New Project: ved oppstart av nytt 
prosjekt. Velg dette første gang du skal bruke 
ArchiCAD. 

2. Open a Project: åpne et eksisterende prosjekt. 
Denne bruker du dersom du allerede er i gang 
med å tegne i ArchiCAD. 

3. Browse for a Solo Project: finn solo- prosjektet 
man ønsker å åpne på 
maskinen/nettverket/serveren. 

4. Browse for a Teamwork Project: finn 
TeamWork-prosjektet man ønsker å åpne på 
maskinen/nettverket/serveren. 

5. Select a recent Project: velg et av de siste 
prosjektene som er jobbet med på denne 
maskinen fra denne listen. Velg et av BoligABC 
- prosjektene eller et prosjekt du selv har 
startet med i forhold til Oppgave C.   

6. Set up Work Environment: velg arbeidsoppsett. 
Velg BoligABC. 

7. Open: velg Open når du er ferdig med å legge 
inn de innstillingene du ønsker.  
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LAGRING 

 

Lagring mens man jobber er viktig.  

Det ligger en AutoSave-funksjon i programmet som lagrer hvert 6. minutt, men denne vil kun kunne 

åpnes dersom man har hatt en maskin-crash (strømbrudd, maskin-crash etc.) Dersom man har 

opplevd en maskin-crash skal man ikke åpne filen, men programmet på nytt. Man vil da få 

muligheten til å åpne filen som automatisk er lagret.  

Velg alltid å lagre ved hjelp av File > Save før man begynner å tegne, slik at man har en destinasjon å 

lagre mot underveis. Man velger da både navn på filen og hvor den skal ligge.  

Det typiske ArchiCAD-formatet er ArchiCAD Solo Prosjekt (.pln).  

 

ENDRE PROSJEKTINFORMASJON 

 

 

Trykk på informasjonsknappen som vist ovenfor for å endre prosjektinformasjon. Dette legges inn for 

at det skal komme frem informasjon om prosjektet i tittelfeltet på tegningene. Du endrer innstillinger 

under Description.  
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PALETTER 

VERKTØYLINJE ØVRE 

 

 
 

 
Velg alt 

 

 

 
Send element 
framover 

 

 

 
Send element bakover   

 

 
 

 
Dra 

 

 

 
Roter 

 

 

 
Snap Points 
(hjelpepunkter) 

 

 

 
Snap Special 
Options 

 

 

 
Rutenett. 
Med denne velger du 
om rutenettet skal 
være synlig 
 

 

 

 
Vis planvindu. 
2D tegning 

 

 

 
Vis alt i 3D 

 

 

 
Parallellvisning i 3D 

 

 
 

 
Perspektivtegning i 3D 

 

 
 

 
Orbit. 
Navigere i 3D, snu 
modellen 

 

 

 
Explore.  
Navigere i 3D, 
perspektivtegning. 
(Gå/vandre i 
perspektiv) 
 

 

 
 

 

 
Trimme vegg til tak og 
Bolske operasjoner 
Disse to bruker du for 
å tetteåpning mellom 
vegg og tak. Se 
Tilpasse veggene til 
taket, s.?? 
 

 

RUTENETT 
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3D NAVIGERING 

Det finnes to forskjellige måter å se 3D-modeller på; parallellprojeksjon eller perspektiv. Ved 

paralellvisning er alle sider like lange og kan således skrives ut i målestokk. For å gå til 3D-

vinduet kan man trykke på 3D-knappen på verktøylinjen.  

 PARALLELLPROJEKSJON 

For å aktivere perspektivvisningen klikker man på parallell-knappen på verktøylinja. Ved 

parallellvisning i 3D vil alltid modellen være i sentrum av vinduet. Trykk på knappen Orbit, 

det vil da komme opp et kryss midt i vinduet sammen med at kursoren på musen endres. For 

å navigere, klikker og holder man nede venstre museknapp samtidig som en beveger musen 

den retningen man ønsker. Klikk ESC for å avslutte navigeringen.  

 PERSPEKTIV 

For å aktivere perspektivvisning klikker man på perspektiv-knappen på verktøylinja. Man kan 

navigere enten ved hjelp av Orbit (samme metode som ved parallellvisning) hvor 

siktepunktet i modellen er sentrum eller ved å vandre/fly. For å vandre/fly trykker man på 

knappen Explore (knappen på verktøylinjen som ser ut som et menneske). Klikk enten ESC 

eller med musen for å avslutte navigeringen.  

 

Dialogboksen for navigering i perspektiv. 
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INFOPALETTEN ς informasjon om hvordan velge verktøy 
 

 

 

Det er viktig å følge med på denne. Infopaletten gir hele tiden hjelp ved å vise innstillingene på 

elementene, enten det er standardverdier eller verdier på et valgt element. Her kan også enkelte 

innstillinger legges inn, for eksempel lagvalg, ID etc. Infopaletten henger sammen med 

verktøypaletten og gir alltid informasjon om det verktøyet som er aktivt. 

 

Notater:
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VERKTØYPALETTEN 

 
Denne brukes som hjelpemiddel til tegningen. Her finner du pilverktøyet, alt du trenger for å tegne 

vegger, vinduer, dører, gulv etc. og dersom du skal avsette mål, vinkler, sette inn tekst etc. til 

modellen.  

 

 

 

¶ Pilverktøy (Arrow Tool): Marketing 

¶ Områdeverktøy (Marquee Tool): Marketing, utsnitt, editering 

 

 

 

 

 

¶ Veggverktøy (Wall Tool): Tegne vegger, yttervegger og innvendige vegger 

¶ Dørverktøy (Door Tool): Sette inn dører, ytterdører og innvendige dører 

¶ Vindusverktøy (Window Tool): Sette inn vinduer, du kan endre type vindu 

¶ Takverktøy (Roof Tool): Tegne tak 

¶ Bjelkeverktøy (Beam Tool): Sette ut bjelker 

¶ Søyleverktøy (Column Tool): Sette ut søyler 

¶ Dekkeverktøyet (Slab Tool): Tegne grunnflate, etasjeskille 

¶ Trappeverktøy (Stair Tool): Sette ut trapper, både utvendig og innvendig 

¶ Terrengverktøy (Mesh Tool): Tegne terreng 

¶ Soneverktøy (Zone Tool): Denne brukes for å finne areal, volum og overflate 

¶ Objektverktøy (Object Tool): Sette inn objekter, f.eks trær, stoler, mennesker 

¶ Lysverktøy (Lamp Tool): Sette inn lamper og lys 

 

 

 

 
 

¶ Snittverktøy (Section Tool): Tegne snitt, og vise modellen vertikalt/loddrett 

¶ Fasadeverktøy (Elevation Tool): Tegne fasader, endre fasade 

¶ Målsettingsverktøy (Dimension Tool): Målsette 

¶ Vinkelmålsettingsverktøy (Angle Dimension Tool): Målsette vinkler 

¶ Radiusmålsettingsverktøy (Radial Dimension Tool): Målsette radier 

¶ Tekstverktøy (Text Tool): Sette tekst til modellen 

¶ Skravurverktøy (Fill Tool): Skravere på modellen 

¶ Linjeverktøy (Line Tool): Tegne linjer 

¶ Sirkelverktøy (Arc/Circle Tool): Tegne sirkler og buer  

¶ Polylinjeverktøy (Polyline Tool): Tegne sammenhengende linjer 

¶ Importverktøy (Drawing Tool): Verktøy for å plassere tegninger på tittelark (se s. xx) 
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FAVORITTPALETTEN  

 

 

 

Favorittpaletten for vegger 

 

 
 
Favorittpaletten viser til de mest brukte mulighetene innenfor de ulike verktøyene. For å finne flere 
elementer innenfor det enkelte verktøy, marker det som skal endres med pilverktøyet > høyreklikk 
med musepekeren > velg eks. Wall Selection Settings (dersom du er inne i veggverktøyet) > her kan 
du endre til ulike andre type vegger (Se 1. etasje ς yttervegger, innervegger og vegginnstillinger, s. 
??). Paletten gir deg også enkelt mulighet til å lagre og hente inn igjen elementinnstillinger. Det er 
ulikt antall favoritter under de ulike arbeidsverktøyene, og ulike favoritter er tilgjengelig ut fra 
hvilken mal du valgte da du åpnet ArchiCAD ς BoligABC (eks. Oppgave B  -Enebolig).  
 

 

Notater: 
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NAVIGATØREN ER OPPDELT I FIRE DELER 

Denne paletten gjør det mulig å navigere i 
prosjektet på en rask måte, samt effektivt å 
hente ut informasjonen fra modellen. 
 

 

 
 

1. Project Map:   
Det gir en oversikt over alle tegninger inne i 
prosjektfilen. Når en ny tegning lages 
(etasje, snitt, detalj etc.) vil den automatisk 
vises her 

2. Wiew Map: 
Her er tegningssettet som inneholder 
visninger av modellen (plan, snitt, fasade, 
3D etc.) med lagrede innstillinger 
(målestokk, etasje, zoom, laginndeling og 
visningsvalg) 

3. Layout Book: 
Her er layouter for hele prosjektet 

4. Publisher Set: 
Her defineres tegningssettet for å få dem ut 
på rask måte (print, plott, lagring) 
 
(Se bilde nedenfor) 

 

 

1 

 

2 

 

3 

 

4 
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1.  Project Map: den dukker alltid automatisk opp i alle filer når man starter et nytt prosjekt, og 

er en oversikt over alle tegninger i prosjektet. Innholdet utvider seg når man lager nye 

etasjer, snitt, fasader, detaljer etc. Dobbeltklikker man på en etasje, vil man få vist denne 

med de lag, målestokk og innstillinger som sist var i bruk i programmet. Dette er tilfelle så 

lenge man står i visningen Project Map.  

2. View Map: man bruker tegningssett som inneholder lagrede views (visninger) av modellen. Et 

view inneholder innstillinger for hvordan en tegning skal se ut. Dette sørger for at views alltid 

har riktig visning og at det er lett å komme tilbake/bruke riktig tegning i de riktige 

situasjonene. Det er tre grunner til å bruke view: 

- Plassere tegninger i layoutboken (riktig visning på utskift) 

- Eksport til andre filformater (like tegninger ved hver eksport) 

- God arbeidsflyt (jobbe i riktig tegning) 

Det ligger ferdig definerte tegningssett med views fra forskjellige faser av prosjektet. Dette 

gjør det raskt og enkelt å bruke riktig view. Skisse/forprosjekt, byggemelding, 

arbeidstegninger, salgstegninger etc.  

3. Layout book: 

 

Layoutboken inneholder ark (layouter) som man plasserer tegninger på. Alle ark må ha en 

mal. En tegning som er plassert på et ark blir kalt en drawing.  

4. Byggemelding: inneholder tegning av fasader, plantegning, snitt etc. Byggemelding er en 

melding til kommunen om at man skal bygge et hus. Byggemelding skal brukes på bygg og 

tilbygg hvor bruksarealet eller bygd areal ikke er større en 50m2. Byggemelding kan brukes 

når elevene skal få godkjenning til å kunne få mulighet til å bygge huset sitt.  
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MISTET PALETTER/VERKTØYLINJER  

Hvis man har klikket bort eller ikke finner igjen ikoner i verktøylinjen kan disse hentes opp 

igjen under Window > Toolbars. Er det derimot palettene som mangler finnes disse under 

Window > Palettes.  

 

RESET TIL BOLIGabc OPPSETT 

Dersom man har krysset vekk en del paletter/verktøylinjer, flyttet elementer rundt eller ikke 

finner igjen funksjoner, kan det være lurt å resette til BOLIGabc oppsett. 

 

 

 

1. Velg Options > Work Environment > Work Environment. 

2. Stå på Work Environment Profiles 

3. Klikk på BOLIGabc i listen Stored Profiles 

4. Klikk på Apply Schemes of Profile 

5. Klikk Applay I dialogboksen som dukker opp 

6. Klikk OK nederst til høyre 
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QUICK OPTIONS  

 

 

Her kan du raskt velge lagkombinasjon (hva 
som skal vises i vinduet på tegningen ς velger 
man salgstegning her kommer kun huset med 
vegger uten tak, velg derfor alle lag på), 
målestokk, konstruksjonsvisning, pennesett, 
visningsvalgskombinasjon og måleenheter.  
 
Slik kan modellen vises med det utseendet 
som det skal jobbes og/eller presenteres i. 

 

 

Notater: 
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HJELPMENY 

I ArchiCAD finnes det en omfattende og digital brukermanual som du finner under Hjelp-

menyen eller ved å trykke F1. Den inneholder utallige bilder og forklaringer. Du kan lett finne 

det du er ute etter med enten index-listen eller ved å bruke søkefunksjonen. Trykk på Print-

ikonet for å skrive ut interessante temaer. Nedenfor ser du hvordan Hjelp-menyen ser ut.  

 

 

 

ZOOM 

Når man tegner i ArchiCAD er det viktig å kunne flytte seg raskt rundt i tegningen. Du må ha 

en mus med scrollhjul!  

¶ Rull forover for å zoome inn. 

¶ Rull bakover for å zoome ut. 

¶ Ved å trykke og holde scrollhjulet inne mens man beveger kursor, vil man kunne 
panorere (dvs. bevege seg rundt i modellen) i tegningen. 

¶ Fit in Window: Nederst på alle vinduer er det et forstørrelsesglass med fire piler i. 
Klikker man på dette ikonet vil alt som ligger i tegningen, husmodellen og tomten, 
tilpasses vinduet. Da er man sikker på at ingenting ligger skjult utenfor.  
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TEGNETEKNIKKER ς MODELLERING 

 

MARKERING AV OBJEKTER 

Markering av vegger og objekter etc. skjer med pil-verktøyet, slik at disse er markert grønne. 

Når de er markert kan man gjøre de endringene man ønsker, eventuelt flytte, forstørre, snu 

eller eventuelle andre endringer. 

 

ENDRING AV INNSTILLINGER 

Dersom du ønsker å endre på noen innstillinger, gjøres dette likt for alle verktøyene. Du 

velger samme fremgangsmåte for å finne innstillingene. Nedenfor vises eksempel på 

innstillingsmuligheter for dekke- og gulv ς verktøyet. 

 

 
 

 
 
 
For å endre ytterlige innstillinger på 
dekke/gulv må du markere det aktuelle 
(grønn, se bilde neste side), og deretter 
høyreklikke med musepekeren. Du kommer da 
til en rute hvor du velger Slab Selection 
settings, da kommer du inn i vindu til venstre. 
Her kan du endre ulike innstillinger.  
 
For å endre overflateinnstillingene Model, bør 
du trykke ut lenken slik at du kan endre den 
enkelte innstillingen, se rød pil.  

 

 

Notater:
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Når du skal endre på innstillinger, må du markere objektet du skal endre, slik at det blir 

grønt, som vist nedenfor. 

 

 

TOMT/TERRENG ς denne brukes til oppgave nivå C 

Nedenfor kan du se hvordan terrenget/tomten vil se ut før elevene starter tegningen av 

huset i 1. Etasje. Tomtegrensen er fast, og huset skal tegnes innenfor byggegrense. Det skal 

ikke tegnes inn noe i Terrengnivået annet enn om man ønsker å endre på noen av 

innstillingene i hagen eller gårdsplassen.  
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1. ETASJE ς DEKKER/GULV, YTTERVEGGER, INNERVEGGER OG 

VEGGINSTILLINGER 

 

 

For å starte tegning av huset må 

du være inne i 1. etasje under 

Navigator ς Project Map. Her kan 

du begynne å sette inn 

dekker/gulv, yttervegger og 

innvendige vegger. Under 

Favoritter for gulv- og 

veggverktøyet kan du finne ulike 

type gulv eller vegger. Når du 

tegner veggene, og du har laget 

veggen så lang du ønsker, må du 

klikke en gang på venstre 

musepeker for å sette veggen.  

 

 

Tre metoder for å sette opp dekker og gulv 

Når du klikker på gulvverktøyet, Slab Tool, kan du velge mellom tre ulike metoder for å sette 

opp gulv. Geometrimetoder for dekke/gulv: 

 

1. Flerkantet. 

2. Rektangulær. 

3. Rektangulær rotert. 

 

Notater:
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To ulike metoder for å sette opp vegger 

For vegger er det to ulike metoder for å sette opp vegger, metodene bestemmer hvordan 

man ønsker å tegne ut elementet. Velg mellom rette eller sirkulære/buede vegger. De rette 

veggene er standard.  

Geometrimetoder for vegger:  

 
 

1. Enkel/kontinuerlig/rektangulær/rotert rektangulær. 

2. Buet ved hjelp av senterpunkt og radius/omkrets/tangent. 

 

Tegneverktøy ς lengde og vinkel på veggen man tegner 

 

 

Når man starter å tegne vil det automatisk dukke opp 

en koordinator - boks (tracker) på skjermen som 

inneholder Distance (D)og Angle (A). Veggen vil få den 

lengden man fyller inn på Distance og vil gå i den 

vinkelen som angis.  

 

Notater: 
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MÅLSETTING AV TEGNINGEN  

ArchiCAD har enkle og arbeidsbesparende verktøy for å målsette. Lengder, buer, radier, 

vinkler og høyder kan målsettes både på plan og snitt. Endres bredden på et vindu, lengden 

på en bue osv., endres selvfølgelig også målene. Måltallene er knyttet til elementet i 

modellen.  

 

 

 

 

SETTE UT MÅLSETTING MANUELT 

 

1. Klikk på målingsverktøyet. 

2. Klikk på hakemarkeringer/sort blyant på de punktene som ønskes målsatt.  

3. Dobbeltklikk på utsiden når alle ønskede punkter er klikket på. 

4. man får nå en hammer og en linje på kursor, trykk denne der man ønsker mållinjen.  

 

Etter at målsettingen er satt ut er det fortsatt mulig å gjøre endringer. Kanskje er det 

punkter på mållinjen som ønskes fjernet eller nytt vindu settes inn og ønskes med i 

målingen.  
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FJERNE MÅLPUNKTER 

1. Marker det målpunktet som skal bort (med hakemarkering). 

2. Trykk Delet-tasten. Målpunktet slettes og resten av mållinjen oppdaterer seg.  

 

LEGGE TIL NYE MÅLPUNKTER 

1. Marker hele mållinjen (mercedestegn på mållinjen). 

2. Hold så Ctrl/Eple nede og klikk på de punktene som skal legges til. Målpunktet legges 

til og resten av mållinjen oppdaterer seg.  

 

 

MÅLESTOKK 

 

 

 

Når man tegner i ArchiCAD tegner man 

normalt i målestokk 1:100. Man kan velge å 

vise modellen i den målestokken som man 

ønsker i Quick Options, alternativt Document 

> Floor Plan Scale. Målestokken bestemmer 

hvor stor tegningen av huset skal fremstå.   

 

Notater: 
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SONEVERKTØYET ς AREAL, VOLUM, ROMFARGE OG ROMSTEMPEL 

(Zone Tool) 

Ved bruk av dette verktøyet, kan du måle arealet av hvert enkelt rom i bygget, og sette 

betegnelse på de enkelte rommene (kjøkken, soverom, stu, bad etc.) 

 

 

 

Notater: 
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VELG DØRVERKTØYET ELLER VINDUSVERKTØYET 

Eksempelet som er vist nedenfor viser utsett av dør, men utsetting av vinduer fungerer på lik 

måte.  

 

 

 

PLASSERING MED SENTERUTSETT 

 

Velg senterutsett i Infoboksen 

 

 

1 Beveg kursoren over ønsket plassering i veggen og klikk når en hake vises.  

2 Beveg kursoren den vei døren skal slå (marker tydelig med øyet). Der døren skal være blir 

enten strek innover marker eller utover. Dette henviser til hvilken vei døren går.  

3 Klikk når øyet er i ønsket posisjon. Døren vil deretter være ferdig satt ut.  
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PLASSERING MED KANTUTSETT 

 

Velg kantutsett i Infoboksen 

 

1 Beveg kursoren over ønsket plassering i veggen og klikk 

2 Beveg det doble øyet til den siden av utsettingspunktet døren skal plasseres 

3 Beveg kursoren den vei døren skal slå (marker tydelig med øyet, som forklart ovenfor) 

4 Klikk når øyet er i ønsket posisjon. Døren vil så være ferdig satt ut.  

 

DØRER 

 

 
 

 

Denne innstillingen 
fungerer på samme måte 
for vinduer. 
 
For å endre ytterlige 
innstillinger på døren må 
du markere døren (grønn) 
og deretter høyreklikk. Du 
kommer da til en rute hvor 
du velger Door Selection 
settings, da kommer du inn 
i vindu til venstre. Her kan 
du endre ulike innstillinger.  
 
Her velger du om det er 
innervegg eller yttervegg 
du skal ha, eller garasjedør. 
Du velger også hvordan 
type dør.  
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REDIGERING OG EDITERING 

Alle editeringsmuligheter ligger i menyen Edit. Flytepalettene for redigering-/editering får du 

frem ved å klikke på hjørnet eller siden av et markert element.  

Her kan du finne mange ulike redigeringsmuligheter for alle områder innenfor 

tegneprosessen. Heriblant, vinduer, dører, vegger, tak, terreng etc. 

 

 

ETASJER 

I tillegg til å tegne på ulike lag, eks. gulv og vegger i 1. etasje, tegnes det også i ulike etasjer. 

Etasjene terreng, 1. etg og og tak ligger som standard. Innstillingene for disse 

bestemmes/endres i settingsboksen under som kommer fram ved å velge Design > Story 

Settings.  

Når man lager en ny etasje får man i utgangspunktet et nytt tegneark over/under det som 

allerede eksisterer med en gitt avstand.  

 

 


